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Working-with-Microsoft-Word Tutorial 5

Saving Formatting Templates

www.aseasonofhappiness.com
com

Formatting of Text Boxes
Text boxes can be very useful, especially in presentations and brochures.  They can be
placed in a document and moved wherever needed; however, their placement may
affect other elements such as text and images.  Learning the right format for the job can
save much frustration and re-working.

Overlaying and Grouping Text Boxes
As well as using text boxes in the same plane as text, they can be overlayed one on top
of the other.  There will be times when two or more text boxes need to be kept together
as a group.  This makes moving easier. There are, however, some rules to know about
when grouping, because the original format might change, affecting how they influence
nearby text.

Review-Exercise 4
Exercise 4

With luck, and your newly acquired Word skills, your private letter template should look
similar to mine.  Notice that I have made it more personal by using Jane instead of JJ.  I
have also reduced the Font size of the copied example in this text box to save space.

Jane Doe  3/52, Central Drive, Scotsville, GARLAND 54321
email: jjdoe@jiggermail.com mobile: 8800 555 222

February 24 2018

Dear

message.

Regards

Jane

WT-5
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Part 1 – Introducing Text Boxes

Open Word-Letter Template (Priv). Let’s try putting your name and address somewhere
else below the centralised one. Drop the cursor on the line above the date and Enter 6
times – I’ll explain why shortly. Re-type (don’t copy and paste) your details like this:

J J Doe
3/52, Central Drive
Scotsville
GARLAND 54321

Select the lot, Ctrl+R, and you should have this: Because everything is right-aligned it
doesn’t look too neat. I am now going to introduce you to the very
basics of Text Boxes. Click anywhere to de-select, then open the

“Insert” tab

Left-click, hold and drag right and down to
create the text box (left and up works too). J J Doe
Make it roughly a size which will take your 3/52, Central Drive

address details; Scotsville
then release the mouse button. GARLAND 54321

A cursor is already flashing inside the box and this is where the text will start from.  Select
and Ctrl+X your right-aligned details, left-click inside the text box; and Ctrl+V.  You may
have to adjust the size of the box to fit your text.  To do this, click, hold and drag any of the
dots in the corners, or a square on a side of the box; release the button when okay.

Click inside the box to drop the cursor, Ctrl+A to Select ALL and Ctrl+L to left align.  This
confirms you can perform the same formatting procedures inside a text box as you can in
your main document.  In effect, a text box is simply a page within a page.

Some lines may word-wrap to the next
because they are too long for the width of the
box.  Grab one of the square side-handles and
drag out until it all looks neat.

By doing this, there may be too much space at the bottom.  Drag the bottom square handle
up to reduce it.  You should end up with something like mine, above right.

Drop down the Text Box options.
Forget the templates: just click on:
Draw Text Box at the bottom.

J J Doe
3/52, Central
Drive
Scotsville
GARLAND
54321

J J Doe
3/52, Central Drive
Scotsville
GARLAND 54321

You will be presented with a +

J J Doe
3/52, Central Drive

Scotsville
GARLAND 54321

The text box must be drawn ABOVE
the address, otherwise it will disappear

when you Ctrl+X to cut.
That’s why the 6 Enters first.
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Text boxes can be positioned almost anywhere.  Move the mouse I marker over one of the
borders of the box and a cross with arrow-heads will appear.              This is the move tool.
It can also help to locate a text box, even if it seems invisible.  For now, mouse to the text
box border and when the cross appears, left-click, hold and drag your name and address to
sit against the right-hand margin and below your centralised version.

The default text box comes
with a black border and a white
background fill.  To remove the
border: bring up the cross with
the arrows and right-click.  This
will give you a drop-down.
Left-click on Format Text Box...

Colours and Lines is default.
Left-click the Line Color drop-

down, then left-click the No Color box;
then left-click OK.

All that should now be visible is the text in the box.
As long as you know certain text is in a box, but there are no
border lines visible, you can still locate it.  Just move the mouse
around near where you think the border should be and
eventually the move tool will appear.  Left-click and the re-size handles are shown.  The box
can now be re-sized or moved to suit. Save and Close your Word-Letter Template (Priv).

TIP: When working with text boxes, leave the border lines visible until the layout is finished.
That way you will have no trouble with locating and repositioning, etc during the early stages.
Before finalisation, just go around each box in turn and make any unnecessary lines invisible
with the above procedure.

Part 2 - Formatting Text Boxes

Open a Word-Basic document and Save As... Word-Text Boxes. Copy the header above
(minus the “Part 2 –“ ), with a single space below; then Enter again and make the new
paragraph Normal and left-aligned.  Now, Enter 6 times. Next, using the mouse or
keyboard, Select from the PDF the highlighted text below:

When a text box is first drawn, its default formatting gives it
a black border line of .75pt thickness and a white
background fill.  If you left-click on the border, then right-
click and select Format text Box...
the panel shows the text box to be set in front of text.
This means that the box can be moved anywhere; but because it has a solid background fill,
it will obscure any text underneath.

J J Doe
3/52, Central Drive
Scotsville
GARLAND 54321
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Now Copy, and Paste where the cursor is flashing at the bottom of your page. If you haven’t
already done so, read the text you just copied from and take notice of the associated
Microsoft Word screen-print - the Format Text Box menu.

Now I want you to draw a text box.  If you can’t remember how, refer to Page 43 of this
Tutorial.  Make sure you do this in the space above your text. You need the width of the box
to be about one third of the first line of text below; and when you have this, drag the bottom
border down to just above the last paragraph and release the mouse button.  You will see
the effect of the “In front of text” formatting (in the screen print on the previous page). Left-
click inside the box and notice where the cursor is flashing. You are going to change this.

Find the move tool on the border and right-click to bring up Format Text Box... You are in
the “Colors and Lines” panel (see the tabs at the top).

Switch to “Text Box” with a left-click.  You’ll see the default margin settings for left, right, top
and bottom, and these can be changed to suit your purpose.  Below the margins there are
three alignment selectors which are self-explanatory.  Let’s test these formats.

Close the Format Text Box panel; then Select and Copy the last paragraph of your text, left-
click in the text box and Paste.  Re-size the box using the appropriate handles so that all of
the text is visible, then drag down the bottom border so that the box is tall and skinny with a
good space under the text (don’t worry about the text beneath that it covers). Left-click in
the box and Ctrl+A to select all; then, go to the “Home” toolbar and reduce the Font size to
Arial 8pt.  Now, open the Format Text Box... panel again and make these changes: left and
right margins to 0.75 cm; and top and bottom to 0.3 cm. Left-click OK.

Compare your work with my efforts:

The next section involves quite a bit of formatting.  Don’t worry – there are step-by-step
instructions.  However, because you will be using the mouse for most of the changes, it will
be quicker once they are made, to left-click the OK button at the foot of each menu, rather
than wasting time Entering using the keyboard.  Actually, in some instances, Enter won’t
work; so stick with the mouse for these tasks.  Just remember – it’s a left-click to OK.

This means that the box
can be moved
anywhere; but because
it has a solid
background fill, it will
obscure any text
underneath.

This means that the box
can be moved
anywhere; but because
it has a solid
background fill, it will
obscure any text
underneath.

You should have something
like the box on the left.

If you now return to the
Format Text Box... panel and
select “Bottom” Vertical
alignment, the box should
look similar to mine on the
right.  If not, just drag the
bottom border down a little to
test it out.

Save your file before going to
the next part.
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This means that
the box can be
moved anywhere;
but because it
has a solid
background fill, it
will obscure any
text underneath.

Part 3 - Changing the Layout Format of Text Boxes

Okay, so you have a text box that you can move around, but, because of the default format,
if it sits over a block of text, it will obscure it.  You are now going to apply a number of
different layout formats to see how they can be changed to suit a specific purpose; but for
this you are going to use a copy of both the text box and the original body of text. First,
move the text box up so that it is clear of the text you copied.

Drop the cursor after the end of the paragraph (in the document, not the text box), and
Enter, Enter. Now, go back, Select the text and Ctrl+C to copy. Ctrl+End and Ctrl+V to
paste. This creates a duplicate of your text body.  Next, go up to the text box, right-click on a
border to select, and left-click Copy.  Left-click in a space outside the box and Ctrl+V. Your
copy should appear slightly offset and over the top of the original.  Move the mouse until the
move tool appears; then left-click, hold and drag the copy towards the foot of the page, but
temporarily release the mouse button when it is over the text.  This confirms the box has the
default layout formatting of the original because it also covers the text.  Pick it up again and
drop it below the last line of text. Note the combined use of mouse and keyboard.

Right-click on the border of this box and go to Format Text Box... in the usual way.  Click on
the “Layout” tab to open the panel and left-click on the “Behind Text” option and OK.
Nothing seems to have changed; but if you pick up the box and drop it within the text above,
you’ll see that it now sits in the background.  For text, this is pretty hopeless; but it is worth
remembering, because the same technique can be used to place images under text as an
artistic watermark. Move the text box back under the text and try something different.

Right-click for Format Text Box..., and this time select the “Square” option and OK.  Once
again, it just looks like the original box. Left-click on the border and release the mouse
button. Hold down the Arrow up key and watch it slide upwards, shunting each line of text
to the right as it comes into range.  Now, try holding down the Arrow-right key.  The box
breaks the text, sending some left and the rest right. If you continue on to the right margin,
text will be blocked on the left.  The text box will even go past the margin of the document
right to the edge; but be warned – taking it to the extreme will render part of it un-printable,
because there is always a fine border edge of the page that printers ignore.

While the text box is over the text body, reduce the height using the top and bottom handles
of the border and move it so that it sits well inside the paragraph with at least a line above
and one below the box.  You will lose sight of some of the text in the box, but don’t worry
about it for now. Go to Format Text Box...  It will still be on the Square option.  Click on
“Advanced...” (bottom right); then the “Text Wrapping” tab at the top. In the presented panel,
select “Top and bottom”, then OK the changes. If you now Arrow the box to the centre of
the first paragraph, you should have something like this:

When a text box is first drawn, its default formatting gives it a black border line of .75pt

thickness and a white background fill.  If you left-click on the border, then right-click and
select Format text Box...
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Try moving the text box up and down to see how it affects the text above and below. With
the Top and bottom layout format set, the box can be moved left or right, but no text will fill
the spaces either side because this format extends across between the page margins.
Ctrl+S to save – close if you fancy a break, and re-open when you resume the tutorial.

Part 4 - Saving Text Box Formats

It’s easy to forget these procedures.  To avoid having to go back to find How-to, it might be
an idea to save the more useful ones to the Word-Format file. In the Word-Text Boxes file,
Ctrl+End and add 6 new paragraphs.  Now draw one text box just inside the left page
margin, starting under the second new text block. Make the width of the box about a third of
a line.  Find the move tool, right-click and left-click Copy.  Next, left-click outside the box and
Ctrl+V.

The copy is already selected. Arrow up until the top and bottom borders are in line with the
box underneath; then hold Arrow right to slide the second box so that it sits beside the first
with a small space between.  Left-click away to de-select the box and Ctrl+V again.  Move
this third box to align with the top and bottom borders of the other two, and to the right just
clear of the second box.

Left-click in the first box to drop the cursor, then type: Default Text Box - in front of text; black
border, white fill; no special formatting.

In the second box type: Text Box – square format; coloured fill, no border; Center vertical
alignment.

In the third box type: Text Box – Top and bottom format; no fill or border; no extra spaces
between text; line spacing single.

Now you are going to go through and format each box in turn as per the text in them.

Obviously, the first one being the default, it can be left as it is.

Find the move tool of the second box and bring up Format Text Box... Select the “Layout”
tab, left-click “Square”, then open the Colors and Lines tab.  Drop down the Fill options and
select a background colour (preferably a lightly shaded one).  Drop down the Line options
and left-click the No Colour box.  Left-click the “Text Box” tab and select Center Vertical
alignment; then left-click OK.

To Format the third box: left-click the “Layout” tab; left-click Square, Advanced..., left-click
the “Text Wrapping” tab, then Select the “Top and bottom” option; left-click OK. Go to the
“Colors and Lines” tab, drop down Fill and Line in turn, and check both “No Color boxes”;
then left-click OK. I have dragged up the bottom borders for neatness, and to save space:

Default Text Box - in front
of text; black border,
white fill; no special
formatting.

Text Box – square format;
coloured fill, no border;
Center vertical alignment.

Text Box – Top and
bottom format; no fill or
border; no extra spaces
between text; line spacing
single.
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Notice that the Top and bottom format hasn’t affected the other text boxes.  You can check
what it does to document text in a moment.  First, left-click inside this third box to drop the
cursor; Ctrl+A, then drop down the Paragraph options from the Home toolbar. Change
Spacing After to 0pt, and Line spacing to single. Left-click OK.

Just to prove a point, find the move tool on the third text box.  Make sure you do this next bit
in one movement.  Left-click, hold and slide the box up into the middle of the document text
above and partially over the text box inside it, then release the mouse button. It makes a
mess, but it does confirm something – whereas the formatting of individual text boxes affects
document text, in most cases, it doesn’t push other text boxes out of the way.  It does,
however, have to follow the rules of “Order”, and we’ll be coming to that soon. Now Ctrl+Z.

It might be an idea to copy the text-box formats to the Word-Formats file. Open your Word-
Formats file and Ctrl+End.  In your Word-Text Boxes file, hold down the Shift key and left-
click each of the three text box borders to Select.  These will be in a batch. Ctrl+C to copy
them to the clipboard. Left-click once on Word-Formats to activate it, then Ctrl+V.

The copies will be pasted well below the last line of text (the indents formatting); so while
they are all still selected, Arrow up to leave the boxes three lines below the text above.
Move the mouse I marker to the line above the boxes and left-click to drop the cursor. Type:
Text Box Formats.  Make it Bold and Centralised.  If you think you might want extra spacing
under the indents format, you can add it now or later.  When finished, Save and Close Word-
Formats. If you need a break, Save and Close Word-Text Boxes.

Part 5 – Overlaying and Grouping Text Boxes

You now know a little of how formatted text boxes can alter the look of a document by
placing them next to or inside text. They can also be used as a design feature.  The
examples below are fairly simple to create.  I’ll show you how.

In your Word-Text Boxes document, drop the cursor at the start of a line of text just above
the three boxes. Enter four times to shunt the text boxes down with the paragraphs.  You
want them back up where they came from, but first you are going to ensure that they stay
together. Holding down the Shift key, left-click on each of the boxes in turn to Select them
as a batch; and while the move tool is still visible, right-click for the options and left-click:
“Grouping > Group”. As they are still selected, move them using Arrow up and leave them
two lines below the last line of document text.  Left-click in a space above the boxes to drop
a cursor, and Enter.  The group moves down the page again.  This is because the Enter was
above them. Ctrl+End and the cursor will now be on the last line below the boxes.

BLUE

YELLOW

RED
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When text boxes are initially grouped together, irrespective of their individual formats, the
group will revert to the “In front of text format.  Check the format of your three grouped boxes
by right-clicking the move tool and look in the Format Text Box... panel, Layout tab.  While in
the panel, left-click “Square” and OK. If your grouped text boxes are still on the page, just
Arrow them to where you want. When I performed this bit of formatting, my grouped boxes
seemed to have disappeared; but they were still there and had dropped to a second page
that had been created. As the group was still selected, I cut them using Ctrl+X, scrolled
back up to the previous page; Arrowed up the cursor to the line where I wanted them; then
Pasted them back with Ctrl+V.

While the group is selected (if not, Select now), use the mouse to move the I marker to an
edge until the move tool appears; left-click, hold and push the group up into the text above
and over the text box there; then release the button.  Notice what this does to the text, and
that it sits on top of the other text box. Ctrl+Z to return the group to its original position.

There are times when adjustments may need making to only one box in a group.  Locate the
move tool for the group with the I marker, right-click, slide into the options > Grouping, then
across to Ungroup and left-click to Select.  Notice how individual boxes are shown with their
respective handles; but, at this stage they are still grouped together.  Left-click outside the
group to de-select first, then find a move tool and click – this box will be selected on its own.
For now, you want to re-group; so Ctrl+Z; then Ctrl+S.

You are now going to replicate the BLUE / YELLOW / RED text box on the previous page.
Left-click at the top of your next page to drop the cursor, Enter, Enter; then and type this:
Text boxes can be layered and grouped as one.  When one is created, it can be re-sized to
suit; copied, then pasted; and the copy can be re-sized separately so that it fits inside the
original it was copied from.  Any number of text boxes can be overlayed, one on top of the
other; then they can be grouped as one for moving and re-formatting to fit the job in hand.

Arrow up to the first line of this second page and type: Layering Text Boxes.  Make it Bold
and Centralised. Ctrl+End to drop the cursor on a line below the new text.  If you don’t have
one, Enter a few times below the text.

Go to the Insert tab and draw a text box below the text about the same size as one of the
boxes in your group next to the left-hand page margin.  Click back to the Home tab.  The
cursor will be flashing inside the box.  Type: BLUE.
Now, Select this word, Centralise and make it Bold.
While the word is selected, move your mouse pointer up
to the Font tools and drop down the Font colour panel.
In the “Theme Color” panel, left-click the White box.

The blue selector highlight is still in the text box, but the
word seems to have vanished. It hasn’t, and you are
going to prove that now.  Left-click outside the box to
clear the highlight, then find the move tool and right-click for Format Text Box...  Go to the
Colors and Lines tab, drop down the Fill Color options and left-click the blue square on the
“Standard Colors” bottom row, third from the right.  Go to the Size tab and change both the
Height and Width to 4cm, then OK. You should have replicated (Fig. 1) on the next page.
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Create the overlayed yellow square by: right-clicking the BLUE box move tool, then left-
clicking Copy; right-clicking outside the box and left-clicking Paste.  This gives you an off-set
duplicate. Right-click on the move tool of this new box for Format Text Box...; and, as you
are still in the size options, make both Height and Width 2.6cm.  Go to the Colors and Lines
tab > Fill, and select the bottom yellow square, fourth from the left, then left-click OK.  You
can barely see the lettering, but if you left-click inside the box, the cursor will appear. Ctrl+A
to Select; drop down the toolbar Font Color options again, and click on the Black “Automatic”
box top left.  No, the box isn’t blue, so type in YELLOW.  Click on a border of the yellow box
to Select, and use the Arrow Keys to tap the box to sit centrally over the blue one (Fig. 2).

All that’s left to do now is make the inner RED box. First, Copy the yellow text box, and
Paste the off-set version as before. Right-click on its move tool, go to Format Text Box and
change the Fill Color to RED (bottom, 2nd from the left).  In the Size panel change both
Height and Width to 1.4cm.  Now go to the Text Box tab; change the Top Internal margin to
0.4cm; and finally Select Center as the Vertical alignment. OK the changes.  Clearly, the
word needs changing.  Click in the box, Ctrl+A to select the old word, then type: RED.  Keep
the black text colour.  Re-position the red box in the centre (Fig.3).  Holding the Shift key,
Select each of the overlayed boxes as a batch, then Group them together. Ctrl+S your file.

Part 6 – Integrating Text Boxes with Text

Open your Word-Text Boxes document (if it isn’t already). On the second page, you have a
paragraph of text with the new layered group of text boxes underneath.  Pick these up with
the mouse and move them up over the text and drop.  They sit over the text, obscuring it.
Left-click outside the box to de-select (if you don’t you will be stuck in Size format, and you
need Layout). Move the mouse to a border for the move tool, right-click and go to Format
Object... (notice that the combined and overlayed text boxes are now regarded as an
Object). Select the “Layout” tab, left-click on “Behind Text” and OK.  The paragraph on the
page now runs over the boxes.

Go back into the Format options and, this time, left-click on Square, then OK. Move the
group up into the paragraph of text above it and you should have something like the
example on the next page.

BLUE

Fig. 1

BLUE

YELLOW

RED

Fig.3

BLUE

YELLOW

Fig. 2
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BLUE

YELLOW

RED

BLUE

YELLOW

RED

Text boxes can be layered and grouped as one.  When
one is created, it can be re-sized to suit, copied, then the
pasted copy re-sized separately so that it fits inside the
original it was copied from.  Any number of text boxes can
be overlayed, one on top of the other, then grouped as one for
moving and re-formatting to fit the job in hand.

The position of the object makes it difficult to read the paragraph which is cut in half. If,
however, you click for the move tool, then hold down the Left Arrow key, you can watch as
it slides towards the left margin, and the text sorts itself out to the right until you get this:

Text boxes can be layered and grouped as one.  When one is
created, it can be re-sized to suit, copied, then the pasted; and the
copy re-sized separately so that it fits inside the original it was
copied from.  Any number of text boxes can be overlayed, one on
top of the other, then grouped as one for moving and re-formatting
to fit the job in hand; but they will then become an Object.

Let’s try something a little bit fancy. Ctrl+End, then Enter down to clear the text box
influence and put the cursor on the left beneath it. Next, click the Insert tab and draw a new
text box that extends across the page from left to right margins and about 2 lines in height.
Type: YOU CAN PUT MORE THAN JUST WORDS IN TEXT BOXES; make it Centralised,
Bold and 14pt.  Now, right-click on the move tool to bring up the Format Text Box... options
and go to the Colors and Lines tab. Click “Fill Effects” (to the right of “Color”), click on the
“Texture” tab and scroll down the choices.  Pick a light background colour that will keep the
black text visible; then OK the changes.  Adjust the height of the box so that the words are
vertically centralised. This is going to be the header for your second page:

Before going on, mouse-click to drop the cursor at the start of the header: “Layering text
Boxes”; then Enter 3 times to shift everything down from the top of the page. You need to
make some final changes to your new fancy header, so right-click on its move tool, go to
Format Text Box... and follow this progression: Layout > Square > Advanced... > Text
Wrapping > Top and bottom > OK > OK. This will cause the text box to displace text on the
document.  It will NOT displace another text box, which is why you needed to move the
group down using the keyboard Enter technique.

The header box is still Selected, and you are going to move it to the top of the page where
the top paragraph line would be. Once a text box is Selected, the cursor cannot be seen, so
it is difficult to know exactly where the top line is.  Click on the “Show hidden characters” tool
on the toolbar to bring up the ¶ marks.  The top one is your target. Hold down the Arrow up
key to slide the header up to the top paragraph mark. Delete 2 paragraphs of space
between it and the header below.

YOU CAN PUT MORE THAN JUST WORDS IN TEXT BOXES
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BLUE

YELLOW

RED

You should have something like this:

Layering Text Boxes

Text boxes can be layered and grouped as one.  When one is
created, it can be re-sized to suit, copied, then the pasted; and the
copy re-sized separately so that it fits inside the original it was
copied from.  Any number of text boxes can be overlayed, one on
top of the other, then grouped as one for moving and re-formatting
to fit the job in hand; but they will then become an Object.

If all’s well, disable “Show hidden characters”, then Save and Close Word-Text Boxes.

Coming next: Working with Images

YOU CAN PUT MORE THAN JUST WORDS IN TEXT BOXES

Exercise 5

You probably have some photos on your PC or laptop.  Pick one you might like to put on
your private letter template and remember where it is located in Windows Explorer.

Open Word-Basic and Save As... Word-Images.  Draw a text box of a suitable size.
Bring up the Format Text Box... options and go to the Colors and Lines tab.  Click “Fill
Effects”; then the “Picture” tab.    Click “Select Picture...”. Browse Windows Explorer for
your chosen photo, left-click on your choice; and Insert. Click the “lock picture aspect
ratio” box, and OK, OK.

If you end up with something like this:

Save the file and Close it.

I’ll show you more on images in the next tutorial.
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WT5 – ADDENDUM FOR 365 USERS

Page 44 To re-format a text-box, right-click on a border for the move tool, left-click
Format AutoShape/Picture.

Page 49 1st paragraph: when choosing the Square format, then OK, 365 does not
seem to throw the Grouped boxes elsewhere in the document.

Page 50 To copy a text box, right-click the move tool and left-click Copy.  When you
right-click outside the box, Paste Options: Keep Source Formatting (K) is the one you want.
Alternatively, right-click to Copy, left-click outside the box, then Ctrl+V.

In 365, formatting Grouped boxes is catered for in the Format AutoShape/Picture option.


